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Use this HyperGlaze Help 
stack as a tutorial or to find 
specific help information.

Windows-specific information 
is in [brackets] in blue text.

Please note that this stack will 
float above other windows, so 
you can leave it open while you 
tryout features in the various 
parts of HyperGlaze.

Click 'Find' again to repeat a search

Print Entire Help Stack

Close

Getting Started

Take some time to browse through the menus and look 
at the glazes, clays and materials that come with 
HyperGlaze. Don't be afraid to try features of 
HyperGlaze and see what they do!

There are many things which you can do with 
HyperGlaze which are quite intuitive. Most of these are 
available as either menu choices or buttons which you 
can click, like the arrows at the upper right of this card.

More complex features such as creating your own 
custom glaze limits, finding  recipes using complex 
searches to narrow down choices, and short cuts may 
require a bit more study of HyperGlaze Help. 

Note: You can turn tool tips on or off in the General 
section of Preferences.

Index

TIP: Many items of have tool 
tips - point to an item and a 
small window pops up with a 
description of its use. Try it!

more...
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      Installing HyperGlaze from the CD-ROM

It's easy to install HyperGlaze on most computers - just 
insert the HyperGlaze CD-ROM and open the 
HyperGlaze X folder. 
Next, drag the folder containing the proper version of 
HyperGlaze to your computer's hard disk. Pick the folder 
which is labeled with your operating system: MacOSX or 
WIndows.  HyperGlaze must be installed to be able to 
save changes.
If you're using a Macintosh computer, drag the 
HyperGlaze application to the Applications folder on 
your computer.
If you're using a Windows PC, drag the HyperGlaze 
Windows folder on the CD to the Progams folder.
YOU MUST ALSO copy the HyperGlaze folder (with 
Glazes, Clays, Materials, Preferences, etc.) to your 
computer's Documents folder!
 (more on next page)

Index

Handy TIP:  Make an alias 
[shortcut] for HyperGlaze and 
put it on your desktop, dock, or 
toolbar.
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    HyperGlaze Installation, continued

You may also have to unlock the files in the HyperGlaze 
folder after copying them from the CD-ROM. Sometimes 
files are left in the Read Only state when copied from a 
CD.
To unlock files so you can save changes to HyperGlaze:

Select your HyperGlaze folder on your computer's hard 
disk (not on the CD). Click on the folder ONCE to select 
it, then choose "Properties" from the File menu. At the 
bottom of the menu you should see a check box next to 
the words "Read Only." Uncheck the box and choose to 
apply that change to all files in the folder. Close the 
Properties window. You can also do this for each file in 
the HyperGlaze folder, one at a time, if you don't unlock 
the files all at once.

Index

Properties tip: Click on the 
HyperGlaze folder, choose 
Properties, uncheck "Read 
Only" and unlock all the files in 
HyperGlaze at once!
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      What's new in HyperGlaze X?

While most of HyperGlaze X will look familiar to users of 
original versions, a few new features are:
   - resize HyperGlaze windows using Screen Scaling
   - an improved look in OSX, with color in all platforms
   - stacks open in multiple windows (see Navigation)
   - simplified navigation
   - easy copy and paste of the text of an entire recipe 
        to word processor or email
   - easier to move glazes between recipe, Glaze
        Calculator and Glaze Limits
   - install your own thermal expansion coefficients or
        use the default coefficients.
   - marked cards & Glaze Lists instead of Utilities List
   - more powerful Complex Search
   - Help stack floats above window - leave it open!
   - improved Compare Glazes, Clays, Materials stacks
   - more popup menus and improved help

Index

more...
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      Important note - Saving changes

HyperGlaze users who are familiar with the original 
versions of HyperGlaze should be aware of a very 
important change in how HyperGlaze saves changes.
In the original versions, changes were saved 
automatically. In HyperGlaze X, the current version, you 
must save changes as you make them. If your computer 
crashes before you've saved, all changes and new glaze 
entries will be lost!

Choose Save from the File menu to save your changes.

Another important aspect: You cannot run HyperGlaze 
directly from the CD-ROM or other locked media. The 
HyperGlaze app must be able to find the HyperGlaze 
folder in your Documents folder on your computer. You 
must copy the HyperGlaze DIRECTLY into the 
Documents folder on your computer. 
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      Macintosh & Windows differences

A few things to note:
HyperGlaze was entirely constructed on a Macintosh 
computer. Certain aspects may look somewhat different 
for Windows users, although both are similar.

In Windows, menus appear within each window instead 
of in the main menu bar. Buttons have a different shape 
in Windows. Fonts and printing may look different, too, 
due to the way Windows works! 

Instructions which are specific to Windows users are 
labeled in blue like this in this help stack: 
      type Command [Control]-N to make a new card
Typically these will be issues such as Macintosh using 
the command key and option key, while Windows uses 
the control and ALT keys for the same operations.

Index

Cross Platform TIP: 
HyperGlaze uses Arial font. 
Make sure it's installed for 
better viewing and printing.
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      Stack window sizes

To make the screen less cluttered and to allow printing 
more compact recipe cards, you can enlarge or reduce 
the size of many HyperGlaze windows. Look for the 
small up or down arrow at the bottom left of a stack, for 
example in the Glazes stack window. Try the tiny version 
to the right to see how this works.

When the window is scrolled up, anything in the hidden 
section will not be printed when you choose Print Card 
unless you're printing formatted. If you want to have the 
comments for a glaze recipe printed, for example, be 
sure to enlarge the Glazes stack window before printing.

In the Glaze Limits stack, buttons and popup menus at 
the bottom are hidden so it will print with less clutter. In 
the Glaze Calculator stack, the two scrolling click-on lists 
of possible ingredients are hidden or shown.

Index

Windows TIP: Windows 
doesn't  always resize its 
windows easily - use 
HyperGlaze's resize buttons to 
enlarge windows to full size.
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      Arranging Your HyperGlaze Windows

You can arrange your HyperGlaze windows however 
you like on your screen. 

If you'd HyperGlaze to remember the current 
arrangement, open the Preferences  window and check 
Save Window Locations (uncheck it first if already 
checked).  Be sure to click Save to close the 
Preferences stack and save  your changes. The next 
time you open HyperGlaze the windows will be 
arranged just as you like them.

Clicking on the window name in the HyperGlaze Index 
will first bring the window to the front, then if you click 
again, it will hide that portion of HyperGlaze. You can 
also minimize windows anytime you want.

Index

Smaller Screen Tip: stack 
windows in staggered layers to 
quickly see what's open. Then 
use the Index stack to move 
between windows.
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      Making back-up copies of HyperGlaze

Once you've added your own glaze recipes, clay bodies, 
and materials analyses to HyperGlaze, you'll want to 
keep a regular back-up copy of HyperGlaze in another 
location besides your computer's hard disk.
To make a back-up copy:
     First save and quit HyperGlaze.
      - for Macintosh OSX or Windows drag the entire  
          HyperGlaze folder to the back-up disk (you need
          to copy Glazes.livecode, Clays.livecode, and         
          Materials.livecode especially as these hold your 
          data and recipes).
          Also backup the HyperGlaze application in the 
          Applications [Programs] folder.
This will protect your investment of time working with 
HyperGlaze in case your hard disk fails (crashes) or 
you're hit with a severe computer virus.

Index

Back-up tip: rename the 
backed up folder HyperGlaze 
BU and put the back-up disk in 
a safe location away from your 
computer!
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HyperGlaze
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Navigating HyperGlaze

The HyperGlaze Index stack (one of the first windows 
you see when you start HyperGlaze) contains a list of 
links to most of the parts of HyperGlaze. You can click 
on each item to show or hide it. Keep the Index window 
in a handy place on your computer screen for quick 
navigation. When a window is selected (the bar at the 
top is hilighted), you can do things in it.

Hiding windows (stacks) using the Index allows you to 
keep your screen less cluttered when you don't need a 
particular tool. Clicking on a name in the Index will show 
that window and bring it to the front, and also hide a 
window if it's already the top window.

You can also use the Go menu to choose which part of 
HyperGlaze to view, including the Index. Try it!  Choose 
Go Back in the Go menu to retrace you path.

Index

more...

Find

Close

      Moving from Card to Card

Besides using the arrow buttons, you can use the arrow 
keys of your keyboard to navigate, too.  The left and 
right arrows will go from card to card, just like the arrow 
buttons on each card. 

The up and down arrows will take you back and forward, 
following whatever path you've taken while browsing. 
Try it!

NOTE: If the cursor is in a text field (where you can type 
or select text, such as the name of a glaze) the left and 
right arrow keys will move the cursor from character to 
character, and the up and down arrows move from line 
to line. Click outside a text field (in a blank area of the 
window) to change the arrow keys back to navigation.

Index

Navigation TIP: Use Go Back 
in the Go menu to retrace your 
steps. It follows your path 
backwards one card at a time.

more...
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      Indexes - browse the recipes

The three indexes, Glaze Index, Clay Index, and 
Materials Index, are one of the easiest ways to browse 
for a recipe or material. Scroll up and down the list of 
recipe or material names, and when you see one you 
want to look at, just point to it with the mouse and click 
the name. The appropriate stack will open and you'll 
instantly see the full recipe.

For instance if you click on a glaze name in the Glaze 
Index, you'll see the Glazes stack open to the glaze 
you've chosen.

Try the tip at the right for quicker browsing. If you don't 
see a name selected in the index, then there is no recipe 
which starts with that letter. Make sure the Glaze Index 
is selected, so you're not typing in a recipe!

Index

Handy Tip: Press any letter 
key (or + or * ) and you'll see 
the list scroll to the first name 
in the index with that letter. 
Press enter to see the recipe.

more...
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      Indexes - Marking Cards

One of the most useful features of HyperGlaze is the 
ability to view and use only a few selected recipes from 
the hundreds you're likely to have in the database. 

Marked Cards are temporarily labeled with a 'mark' 
which is invisible. In the Glaze Index, hold down the 
Option key [the ALT key if you're using Windows]  and 
click a glaze name. You'll see the glaze name change 
from black to red, and a + sign will appear before the 
name. This shows you that the glaze is now marked.

You can view just these marked cards by choosing View 
ONLY Marked Cards from the Find menu of the Glazes 
stack. See the View Marked button (under the arrow 
buttons) turn red? 

Index

QUICK TIP: Click the View 
Marked button, too, to turn 
viewing of marked cards on 
and off. Try it!
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View Marked
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     Lists - Glaze Lists and Clay Lists

The Glaze Lists and Clay Lists stacks offer a powerful 
way to keep groups of recipes easy to use. You can 
quickly build personal or shop lists of recipes by marking 
cards individually or using Complex Search to find 
groups. 

The number of lists is practically unlimited There are five 
lists per page (card). Choose New Card from the Edit 
menu to make new pages (cards) as needed. Name 
each list in the text field at the top of each window, then 
mark recipe cards  to add and click Update This List to 
put the marked cards on that list.

Results of multiple searches can be saved in the Glaze 
or Clay Lists stack, and easily marked again later for 
printing , viewing or export.These lists work like the 
Indexes, click on a recipe name to see it. 

Index

Lists Tip: Use Complex 
Search to find and mark 
recipes to build your lists 
quickly.
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HyperGlaze Basics

Think of HyperGlaze as being like a set of cards, with 
one recipe or material analysis on each card. 

Cards are organized into stacks, much like the pages of 
a book. By clicking on the next and previous card 
buttons you can page from card to card. The arrow 
buttons in stacks with more than one card take you from 
card to card.

There are three databases in Hyperglaze: Glazes for 
keeping your glaze recipes, Clays for storing recipes for 
claybodies, and Materials for storing the material 
analyses which are used in calculating glazes and clays. 
There is an separate index for each of these three 
databases.

Index

Find



Close

      Useful Tools

In addition to the Glazes, Clays, and Materials stacks 
(the recipe and analysis databases) and their indexes, 
there are many other tools in HyperGlaze, such as the 
Glaze Calculator, Glaze Limits, QuadBlender and 
Complex Search. There are separate sections of this 
Help stack which will help you to use each of these tools 
more effectively.

One thing you'll need to know is how to find recipes, 
calculate them and print them. You can use the Find 
menu to do basic searches for one thing, or Complex 
Search to find recipes with a number of different 
chararacteristics. 

More help with finding is on the next page.

Index

Find TIP: Use the simple Find 
menu to look everywhere on a 
card. Press the command 
[control]-F key to find.
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      Finding Recipes & Searching

In the Glazes and Clays stacks you can find recipes by 
looking in particular places for what you want. For 
instance, in the Find menu you can choose Find by 
Color to look for a glaze with a particular color name 
written in the color field (the text field at the top of the 
Glazes stack just to the right of the word color). 

NOTE: HyperGlaze looks ONLY in the color field in this 
search, so colors in the glaze's name won't be found!
There are other menu choices for finding by surface (or 
use in Clays), firing, and cone.
If you find something, you can find the same thing again 
by choosing Find Again from the Find menu.
Use Mark Duplicate Glazes to find and mark recipes 
with the same name and exact recipe so you can delete 
them or change them.

Index

Find Again TIP: Press the 
Command [Control] and "G" 
keys to quickly browse all 
found cards with "Find Again."

more...
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      Finding & Marking Cards

Complex Search will help you to find the recipes you 
want, and then make use of them!

In Glazes and Clays you can search 
for one or several aspects of a glaze, 
and if the seach finds recipes, HyperGlaze marks the 
cards it finds. You can use View Only Marked Cards to 
look at only the cards you've found. Click the right and 
left arrow buttons  in the Glazes stack to go through the 
list of found glazes.
In Complex Search you can choose both where to look 
for glazes and what to do when you find them.  
For now, click on "Find and Mark Cards" before you do a 
complex search. More about the other choices later. 
Choose Unmark ALL Cards in the Glazes or Clays 
menu to clear previous searches before you search.
Hold down the mouse button to cancel searches.

Index

Search TIP: Do several 
different Complex Searches 
without unmarking cards to 
build a bigger list of recipes!

more...
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Find in the Found Set (Marked Cards)
Calculate Custom Limits from Found Set
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      Things to do with Marked Cards

Once you've marked glaze, clay or materials cards you 
can do a number of things using only the marked cards:

     - View just the marked cards
     - Print the marked cards
     - Export the marked recipes or materials
     - Print glaze recipes with the limit graph for each
     - Print glazes as labels (Print Special)

     - Delete the marked cards from the database
     - Add a line of text to all the comments of the 
            marked cards (your shop glazes, for example)
     - Calculate the marked glaze or clay cards
     - Set the batch size for the marked glaze or 
            clay cards

Index

Marking tip: After getting a set 
of marked glazes you will use 
again, add a unique comment 
that allows you to find and 
mark them again quickly.
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      Keyboard Shortcuts

If you'd prefer to use the keyboard as much as possible, 
here are a few keyboard shortcuts:
  Cmd = Command (Apple)= Control on Windows
  Opt = Option Key works like ALT key
       Cmd [Control] - S................Save
       Cmd [Control] - P................Print
       Cmd [Control] - O................Open
       Cmd [Control] - W ..............Close
       Cmd [Control] - Z ................Undo
       Cmd [Control] - X ................Cut
       Cmd [Control] - C ................Copy
       Cmd [Control] - V ................Paste
       Cmd [Control] - [................Go Back
       Cmd [Control] - ]................Go Forward
       Cmd [Control] - Q ...............Quit

Index

Shortcut TIP: print this card 
and the next one and keep 
them handy when working with 
HyperGlaze!

more...
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      More Keyboard Shortcuts

       Cmd [Control] - H................Index (home)

Keyboard shortcuts in the Glazes, Clays, and Materials 
stacks:
       Cmd [Control] - N................New Card
       Cmd [Control] - D................Duplicate Card
       Cmd [Control] - E................Delete Card - no undo!
       Cmd [Control] - F............... .Find
       Cmd [Control] - G................Find Again
       Cmd [Control] - K................Mark Card
       Cmd [Control] - J.................Unmark Card

        Arrow keys...........................Move from card to card      
                or move text selection if cursor is in a text field
In addition, there are letters designated for many keys 
using the ALT key in Windows which do many of the 
same things.

Index

TIP: All of these shortcuts are 
also represented by menu 
choices if you'd rather use the 
mouse.
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      Updating from an older version

If you've been using HyperGlaze for a while and have 
your own recipes and material analyses entered in 
HyperGlaze IIx (the older version) you'll want to move 
those over to this version of HyperGlaze.

Do this by first exporting your glaze and clay recipes and 
materials analyses as HyperGlaze files. Don't export 
them as text. You can export an entire list of recipes at 
once using the Utilities List function of HyperGlaze IIx. 
Then archive your old version. (see printed instructions, 
included, or your manual)

These HyperGlaze files can then be imported by this 
new version of HyperGlaze. The import process may be 
somewhat time comsuming if you have many hundreds 
or recipes or materials. Start each import and go work in 
the studio.

Index

TIP: before importing, you can 
delete all original recipes and 
analyses in HyperGlaze X 
using the Delete ALL... menu 
choices in each section.
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New Recipes - Making a New Card

Choose New Card from the Edit menu to make a new 
recipe card in the Glazes, Clays, or Materials databases. 

New cards cannot be made in most of the other parts of 
HyperGlaze. An exception is the Bibliography stack, 
where you can add your own books and source 
materials.

See the following cards for more help with entering the 
new clay or glaze recipe and calculating it. 

New materials analyses can be easily added in the 
Materials stack, too. See the Materials stack help 
pages.

Index

New Card TIP: Press the 
command [control]-N to quickly 
make new cards.
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      Entering a New Glaze Recipe

Before making a new card for a recipe in the Glazes 
database, take a look at one of the recipes already 
entered in HyperGlaze. You may even wan to print one 
of these recipe cards so you can use it for reference 
when entering your first new glaze.

Click underneath the words  G L A Z E   R E C I P E  at 
the upper right of your new glaze card. You'll see a blue 
line surround the field which holds the name of this 
glaze. Type the name of your new glaze.

Enter the rest of the glaze recipe in a similar fashion, 
clicking in each field (cone,color, surface, ingredient and 
amount, and comments, if any) and then typing the 
appropriate information.  Enter any batch size and 
HyperGlaze converts it to a percentage recipe.

Index

Entry Tip: After typing each bit 
of information, press the TAB 
key to move the cursor 
automatically to the next field!

Find

Close

      Calculating Your New Glaze

Choose Calculate from the Glazes menu. HyperGlaze 
does all the calculations at once: percentage recipe, 
batch recipe, unity molecular formula (UMF), percentage 
analyis, estimated thermal expansion silica/alumina 
ratio, and the batch cost (if you've entered current prices 
for your materials in the Materials stack).

If you've entered a batch recipe intially, it will be 
converted to a percentage recipe, and the original batch 
size is displayed to the right of the amounts.

To change the batch size. click in the batch total field 
and enter a new number, then press the Enter key or 
choose New Batch from the Glazes menu. Click Lb, 
Gm, or Lb/oz to change between measurements.

Index

Calculating TIP:
Press the command [control]- = 
(equal) keys to quickly 
calculate a glaze.
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      Making a copy of a recipe card

In the Glazes, Clays, and Materials stacks you can 
quickly make a copy of the current recipe by choosing 
Duplicate Card from the Edit menu. 

Once you've got a copy of your original card, change the 
name (add "revised," a new color, or something similar), 
and make whatever changes you like to the recipe. 
While HyperGlaze allows duplicate names for glazes, 
you may find it confusing to have a lot of recipes with the 
same name.

Index

Duplicating Cards TIP: Press 
the Command [control] -D keys 
as a shortcut to quickly make a 
duplicate.
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      New Clay Recipes

Clay recipes are entered just like new glazes, but in the 
Clays stack.

All of the same calculations are done, with the exception 
of estimated thermal expansion. Calculations for thermal 
expansion are not accurate for crystalline materials like 
clays (or mat glazes).

You can enter a variety of other information about a 
particular clay body on each clay recipe card, including 
drying, firing, and overall shrinkage. 

Index
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      New Materials Analyses

Go to the Materials stack and choose New Card.

For most simple materials, you can enter a unity 
molecular formula based on the number of molecules of 
the particular oxide supplied. For example for silica you 
would enter 1 in the SiO2 field.

For more complex materials such as clays, feldspars, 
and frits, a percentage analysis (by weight) is usually 
what you'll have from the manufacturer. Enter the 
percentage analysis for each oxide in the appropriate 
field for that oxide. Then choose Convert to Unity from 
the Materials menu.

Index

Molecular Weight TIP:
HyperGlaze will calculate the 
molecular weight for you! Just 
click the Mol Wt. button.

Find

Close

Index - Glaze, Clay, & Material

The three index stacks, Glaze Index, Clay Index, and 
Materials Index, all work in very similar ways. 

The Glaze and Clay Index stacks have three different 
lists of recipe names: Lowfire (cone 022 to cone 1), 
Midrange (cone 2 to 7), and Highfire (above cone 7). 
Click on those names at the top of the index window to 
view each of the lists.

The Materials Index stack has two different lists: 
Materials (which lists all of the materials including clays), 
and Clays (which lists materials labeled as clays on their 
analysis card).

Mark cards for browsing or printing by holding down the 
Option [ALT] key and clicking a name in the index.

Index

Index TIP: After using 
Complex Search, click the 
Update Marked button to see 
the marked recipe names!

more...
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      Browsing, Updating, and Marking

If you use Complex Search on a Glazes, Clays, or 
Materials card to find a group of cards which match your 
search, the found cards are marked. However, to save a 
little speed, HyperGlaze doesn't update the indexes by 
hilighting the marked cards in red.

Click the Update Marked button to have the marked 
cards from a Complex Search show in the appropriate 
index. Edit the marked cards from the index as you 
review each card.

Arrange the indexes at one side of your screen, and the 
databases on the other for easy browsing. Click on the 
recipe you want in the index, and you'll see it in the 
Glazes, Clay, or Materials stack window instantly!

Index

Browsing TIP: Mark the cards 
you find interesting in the index 
as you go - Option [ALT] click 
the name you want.

more...
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      Indexing New Cards

New recipe cards are added to the appropriate index 
menu as soon as you leave the new card. 

Newly added names in the index will be at the top of the 
list and preceded by an asterisk (*).

If you leave the new card and realize you've made a 
spelling mistake in the name, simply fix the mistake on 
the Glazes or Clays recipe or Materials analysis card, 
then go the appropriate index and click the Update Index 
button.

Note that updating the index will remove the + and red 
color of marked cards in that index list, but the actual 
marking of each card will remain. Choose Update 
Marked to restore these labels.

Index

Index TIP: Type a letter or * or 
+ and the index will scroll to 
the first instance. Keep 
pressing that key to browse.
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Glazes - the glaze recipe database

Glazes is the area in HyperGlaze where you can store 
glaze recipes with all the information about the glaze 
you need.

The recipe is shown on the screen in a familiar format, 
and you can type in the original recipe in either 
percentage or as a batch. Either way, HyperGlaze 
converts what you enter to a percentage recipe with the 
base glaze (everything but colorants and additives) 
adding up to 100%. Colorants and other additives like 
bentonite and flocculants are added in the lower part of 
the recipe as a percentage addition. 

When you choose Calculate Glaze, percentage 
conversion, batch, UMF (unity molecular formula), 
thermal expansion, and cost are calculated.

Index

Glazes TIP: Put parentheses 
around an ingredient or note in 
the recipe and it won't be 
calculated.

more...
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      Entering a new glaze

Entering a new glaze is easy. HyperGlaze is set up in 
the format of a typical glaze recipe. First make a new 
card using New Card in the Edit menu. Type the name 
of the glaze at the upper left (under "GLAZE RECIPE"). 
then press the tab key and the cursor will move to the 
field where you type the cone number of the glaze.

Surface and color fields are next, and each has a popup 
menu of standard color and surface descriptions. Click 
on these to choose descriptions which match your glaze, 
or type in your own short description of the color and 
surface.. 

Firing and testing also have pop-up menus, but here 
you'll have to use the menu to enter standard terms.
Next we'll enter the glaze recipe.

Index

Glaze Entry TIP: 
Pressing the tab key after each 
entry will move the cursor to 
the next field.

more...

Find



Close

      The glaze recipe & calculations

The ingredients and amounts for each glaze are typed 
into the fields under those headings. If the dotted lines 
which show the location of each ingredient aren't visible, 
click the button Show Lines to make them visible. 
These lines are hidden whenever you print a card.

Open the Materials Index, and use the list of ingredients 
for reference.  Shift-click a material to add it to the recipe 
without typing. See the tip below, too.

NOTE: You must enter an ingredient and amount on the 
very first line of the recipe (above the top dotted line) 
and not skip lines when entering ingredients. 
HyperGlaze stops calculating at the first empty line!
Do the same in the colorants area, Also Add.

Index

Ingredient TIP: Use the popup 
menus ( + ) at the left of each 
ingredient and colorant field to 
enter common ingredients.

more...
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      Glazes - Thermal Expansion Calculations

HyperGlaze calculates the estimated thermal expansion 
of each recipe when you choose Calculate. You can also 
click the Thermal Expansion button to instantly 
recalculate this quantity.

Please remember that thermal expansion calculations 
are not always accurate and at best represent only an 
approximation of the real world glaze expansion. 
HyperGlaze has some built in warnings about when the 
estimated thermal expansion is most likely to be 
inaccurate.  In any event, you can use the thermal 
expansion numbers to get an idea if changes you make 
to the glaze will likely result in a better glaze fit or not. 
Higher expansion numbers are more likely to craze, 
lower more liketly to fit (between 6.5 and 7.0 for most 
clays), and if too low shivering may occur!

Index

Thermal Expansion Tip: click 
the yellow triangle with the 
exclamation point when you 
see it to find out more about 
your glaze's properties.
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      Percentage Analysis & Mole Ratio

The Percentage Analysis/Mole Ratio field shows these 
calculations of the oxide content of the glaze. Click the 
title bar at the top of the menu to switch between these 
two views. 
The percentage analysis is by weight. The mole ratio is 
similar to mole percentage analysis (multiply each 
number by 100 to get the mole percentage analysis).
These are recalculated by clicking the title bar to switch 
between the views or by choosing Calculate from the 
Glazes menu.
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      The Glazes menu

The Glazes menu includes not only the Calculate, New 
Batch, and Mark/Unmark Card menu choices, but also 
these useful items:
Compare Glazes    Puts this recipe in a new window.
Compare UMFs  Use to compare unity formulas.
Sort by...      Sorts the recipe stack by the aspects listed
   (note that sorting does not affect the the Glaze Index)
Send to Blender      Sends this glaze recipe to the 
QuadBlender. Pick one of the four glazes in the 
QuadBlender stack: Recipe A, B, C, or D. 
Send to Calculator      Sends this glaze to the Glaze 
Calculator stack where you can substitute materials or 
alter the molecular formula and recalculate.
Send to Limits      Sends this glaze to the Glaze Limits 
stack where you can compare the UMF to typical glaze 
analyses for different cones, and adust the firing 
temperature of the glaze.

Index

TIP: Sort the recipe stack 
before browsing.
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      Compare Glazes

The Compare Glazes menu choice brings up a small 
window with a glaze recipe. You can change this to the 
current glaze recipe shown in the Glazes stack by 
clicking the Get Current Glaze button. This recipe will 
stay in the Compare Glazes window while you navigate 
to other glaze recipes in the Glazes stack, allowing you 
to compare both the batch recipe and the molecular 
formulas for the glazes.

Close Compare Glazes by clicking the close box at the 
top of the window or the Close button at the bottom right 
of the window.
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      Compare UMFs

The Compare UMFs menu choice in the Glazes menu 
shows the Compare Unity Formulas window. You can 
click the Get Current Glaze button at the bottom to add 
the currently shown glaze in the Glazes stack to the list 
of unity molecular formulas. By clicking back and forth 
between the Glazes and Compare Unity windows you 
can find and add the glazes you want.

A faster way to add a number of glaze unity formulas to 
the Compare Unity window is to first mark the glaze 
recipes you want to add. You can mark them by hand or 
by using Complex Search to find and mark the glaze 
recipes you want. Then hold down the Option [ALT] key 
and click the Get Current Glaze button to add all the 
marked glaze recipes.
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      Other Glaze card tips and features

If you add a comma after the name of an ingredient in 
the recipe, any words after that will be ignored in doing 
the glaze calculation. Use this for things like mesh size 
that may not affect the chemical content of the glaze 
(although mesh size does often affect glaze melt!).

Use the pop-up menus for color and surface to enter 
standard terms for a recipe. This makes searching for 
these aspects of a glaze easier and more accurate later 
on - the Complex Search form has the same pop-up 
menus!

Put the main color name of the glaze first in the color 
field, followed by modifiers. That way when you sort by 
glaze color, the colors will be grouped together.
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      Picture button

You can take a digital JPEG picture of your favorite 
glazes to save with the glaze recipe.

See the Glaze Picture help page for how to add pictures 
of your glaze that will be displayed each time you go to a 
recipe that has an associated image. The Glaze Picture 
window must be open to see the image.

If no image appears even after you've selected the 
image using the Picture button, go to the Preferences 
and click on the Glazes tab. Click the Set Folder button 
and select the Glaze Images folder.

Click Glaze Picture in the Index window to show or hide 
the Glaze Picture window. 

Index

TIP: A flat-bed scanner can be 
used to scan images of flat 
tiles, but be careful not to 
scratch the glass on the 
scanner! 
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      Importing and Exporting Recipes

You can import and export glaze and clay recipes, and 
material analyes in several formats. Use the File menu 
choice Export. 
HyperGlaze format for glazes and clay recipes makes a 
file that can be re-imported back into HyperGlaze. 
Text format will save a file that can be used with word 
processors, or imported into some other glaze 
programs. This is also the format use for the GlazeBase 
database on the web: art.sdsu.edu/ceramicsweb/
Insight format will create a file which you should be able 
to import into Insight glaze software.

HyperGlaze will also import these same file formats, 
creating a new recipe card for each in HyperGlaze.

Index

Import Tip: Get a lot of new 
glaze recipes to try from the 
GlazeBase database on the 
CeramicsWeb online:
art.sdsu.edu/ceramicsweb/
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      Duplicate Recipes - how to find them

You can quickly find and mark duplicate recipes which 
have the same name and exact recipe by using Mark 
Duplicate Recipes in the Find menu. Update the Glaze 
Index before using this utility, as HyperGlaze first looks 
for duplicate names in the Glaze Index and then checks 
to see if the recipes are exactly the same. When 
HyperGlaze finds a pair of recipes with the same name, 
ingredients and amounts it will mark both of them. You 
can then quickly review these duplicates using View 
ONLY Marked Cards to decide if you want to delete one 
of the recipes or just change it.

NOTE: Mark Duplicate Recipes will unmark all 
previously marked recipes, so be sure you don't need to 
do something with the recipes you've already marked 
before using this utility.

Index

Marking Tip: Make a Glaze 
List of the marked duplicates to 
review them later.
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Glaze Lists

The Glaze Lists and Clay Lists stacks offer a powerful 
way to keep groups of recipes easy to use. You can 
quickly build personal or shop lists of recipes by marking 
cards individually or using Complex Search to find 
groups. 

The number of lists is practically unlimited There are five 
lists per page (card). Choose New Card from the Edit 
menu to make new pages (cards) as needed. Name 
each list in the text field at the top of each window, then 
mark recipe cards  to add and click Update This List to 
put the marked cards on that list.

Results of multiple searches can be saved in the Glaze 
or Clay Lists stack, and easily marked again later for 
printing , viewing or export.These lists work like the 
Indexes, click on a recipe name to see it. 

Index

Lists Tip: Use Complex 
Search to find and mark 
recipes to build your lists 
quickly.
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Glaze Picture

Here's how to add a picture of a glaze that will be 
displayed in the Glaze Picture window:

Take a digital picture of the glaze. Size and crop it in 
your favorite photo editor so that it's about 300x300 
pixels at 72dpi. Try to take the photo so that the image is 
about life size at 72dpi resolution. A flat-bed scanner can 
be used to scan images of flat tiles, but be careful not to 
scratch the glass on the scanner! 

SAVE the image or copy it to the "Glaze Images" folder 
that is inside your HyperGlaze folder.

Click on the Picture button below the Unity Molecular 
Formula in the Glazes window. Choose the JPEG (.jpg) 
file of the glaze  and choose Open.  

Index

TIP: Holding down the Option 
[ALT] key when clicking the 
Picture button allows you to 
choose a new picture to 
display.
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Glaze Limits

Click on Glaze Limits to show that stack, then click the 
Limits for Current Glaze button to see the analysis of 
the current glaze superimposed as light blue bars over 
limits for glazes of the same cone. The limit initally 
shown will be for generic glazes - either glossy or matte. 
Click the Surface: field to change between these two 
choices.

Choose a Custom Limit  from the pop-up menu for 
specific type type of glaze and cone (for example c10 
Shino) to see the glaze limits for a much narrower range 
of glazes.

Click in the light blue bars which represent each oxide 
and drag them up and down to adjust molecular 
amounts for that oxide for later calculation (next card).
Percentage by weight amounts are also shown.

Index

New Glaze TIP: Make a new 
glaze by adjusting the oxides in 
Glaze Limits and then 
calculating a new recipe!

more...
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      Altering a Glaze Using Glaze Limits

Glaze Limits is only a workspace: glaze recipes aren't 
stored here permanently.

Click and drag the light blue bars of each oxide in the 
Glaze Limits stack to adjust that oxide amount. Notice 
that if you move any of the flux amounts (RO), the other 
flux oxides adjust to keep the formula in unity. You can 
drag the oxide bars within the limit amounts if you like. 

You may also see the Estimated Thermal Expansion 
change as you move the oxides up and down. If it's 
empty or doesn't change, click the Thermal Expansion 
field to update it. You'll likely also see a note explaining 
why HyperGlaze isn't calculating the estimated thermal 
expansion. See the next card for calculating new recipes 
after adjusting glaze limits.

Index

Limits TIP: Check the Link 
Ratio box to keep the alumina 
and silica in the same ratio 
when adjusting those oxides.
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      Adjusting the Cone in Glaze Limits

You can use the Glaze Limits card to automatically 
adjust the firing temperature of a glaze formula. Click the 
small up and down arrows to the left of the Limit Cone 
number. Each time you click, you'll be asked if you want 
to change the firing cone of the glaze by one cone 
number. 

IMPORTANT Note: Merely typing in a new cone number 
does NOT change the molecular formula, but only 
changes the limit bars behind the light blue oxide bars. 
You can then adjust the firing temperature of the glaze 
manually.

After adjusting the formula, choose Send to Glaze 
Calculator to calculate a batch recipe from actual 
ingredients. (see Glaze Calculator for more info)

Index

Adjusting TIP: Changing a 
recipe by more than two or 
three cones may alter it so that 
it no longer looks the same.
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      Custom Limit Formulas

You can make and install custom limit formulas based 
on information found in texts or calculated from a group 
of glazes in HyperGlaze.

Go to the Glaze Limits stack, and then choose Install 
Custom Limits from the Glaze Limits menu. You'll see 
the custom limit editing card which looks a lot like the 
Glaze Limits card, but without colored bars. You can 
click and drag the top and bottom of these limit bars up 
and down to set all the oxide limits, then add your 
custom limit name and cone at the top. You can also 
import custom limits that you have calculated using the 
Complex Search feature of HyperGlaze. After you have 
the custom limit set up, you'll need to install it.

More on installing your own custom limit formulas on the 
next Help card.

Index

Custom Limits TIP: Drag 
oxide bars (top and bottom) to 
zero if that oxide is not 
included in the type of glaze 
you're using.

more...
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      Importing and Installing Custom Limits

1. Once you have a custom limit file created, again go to 
the Glaze Limits stack, and then choose Install  
Custom Limits from the Glaze Limits menu. 
2. Next start the import process by clicking the Import 
Limit File button at the lower right of the Limit Formula 
Editor. 
3. You’ll be prompted to locate the custom limit file you 
have created (with file extension ‘.LMT’) and open it. 

Note: You may get a warning “Do you want to install 
(save) the current limit formula before replacing it?” 
when you click the "Import Limit File" button and IF the 
limit formula shown has not yet been installed. If you 
choose “Install” the limit formula which is already shown 
in the Limit Formula Editor will be added to the custom 
limits. If you choose “No” the old custom limit will be 
replaced by the one you are about to open.

Index

Custom Limits TIP:  Name 
limits by glaze type and include 
a surface description - but use 
short names and standardized 
terms 

more...
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      Installing Custom Limits, cont'd

4. Make any changes you feel are needed in the new 
custom limit formula you just opened, changing the 
name, cone, or surface appropriately, and if necessary 
adjusting the limit bars.
5. When you are satisfied that your new limit formula is 
what you want, click the “Install Custom Limit” button.
6. Check that your new custom limt is indeed in the list 
of installed custom limits in the Custom Limit Editor. 
These are automatically sorted by cone number first, 
with a subsort alphabetically by name within each cone 
number.
7. Your new limit should now also appear on the Glaze 
Limits card popup menu of custom limits. Click the 
arrow at the bottom left of the Custom Limit Editor card 
to return to the Glaze Limits card.
8. Choose “Save” from the File menu of HyperGlaze to 
save your new limit formula for use later.

Index

Custom Limits TIP:  Use the 
Complex Search feature of 
HyperGlaze to make. See the 
next card.

more...

Find



Close

      Calculating your own Custom Limits

You can use the Complex Search stack to find a set of  
glazes and then analyse the results by averaging and  
finding the standard deviation for each oxide amount in 
the glazes you have selected. 
1. First do searches using Complex Search to find a 
group of closely related glazes, for example cone 10 
Shino glazes, cone 10 matte glazes containing 
spodumene, or more generally, cone 6 glossy  glazes. 
2. Once you have a group of recipes found and marked,  
review them in the glaze stack using View Marked to 
make sure that the marked glazes are indeed related  
and fit your criteria for a limit formula. 
3. Use Complex Search again to create the limits by 
selecting the Calculate Custom Limits... button. This 
creates both a text file of the average oxide amounts, 
and a custom limit file with the file extension ‘.LMT’ that 
can be imported into the Custom Limit Editor.

Index

Search TIP: 
Hold down the mouse button to 
cancel long searches. You will 
get only partial search results if 
you cancel.
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      Analyze Glaze

Choose Analyze Glaze from the Glaze Limits menu to 
see a short interpretation of how your glaze compares to 
the typical glaze of this temperature.

This analysis of the recipe is very general in nature, but 
may be useful in understanding how oxides affect the 
glaze recipe. Click the Done button to hide the analysis. 
To update the analysis after making changes, choose 
Analyze Glaze from the menu again.
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Glaze Calculator

The Glaze Calculator is where you can reformulate a 
glaze using new ingredients, or modify the UMF (unity 
molecular formula) and recalculate the recipe from the 
same ingredients. 

Click the button Use Current Glaze to put the UMF for 
the currently visible glaze recipe into the Glaze 
Calculator. It will also enter the glaze name, cone, and 
ingredient list. 

Change ingredients in the list to different ones, for 
instance changing to a different feldspar, or using 
wollastonite instead of whiting and silica. Then click the 
Calculate button or choose Calculate from the Glaze 
Calculator menu and see the new recipe.
Save your new glaze using Send Recipe to Glazes.

Index

TIP: the Glaze Calculator is 
only a workspace. Choose 
Send Recipe to Glazes to 
save it as a glaze card.

more...
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      Glaze calc - interpreting results

Take a look at the UMF after you've calculated the glaze 
in the Glaze Calculator. You'll probably see a few 
numbers still in the UMF, and a few which were there 
have disappeared. HyperGlaze deducts the amount of 
each oxide after it adds each ingredient.

Negative numbers in the UMF ( the numbers turn red 
with a minus sign in front, as in the picture at right) 
represent oxides where too much of an oxide has been 
added in the calculation, Usually these amounts will be 
small, and if less than 0.005 can often be ignored. If 
larger, you may need to try different ingredients or 
re-arrange the order of the list with the most complex 
ingredients at the top.
Positive numbers still in the UMF after calculating 
represent oxides still needed. Add an ingredient that 
supplies this oxide to the list, and click Calculate.

Index

Ingredient entry TIP: Click on 
the chemical symbol for each 
oxide and the ingredient list 
scrolls to that oxide & material.
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      Glaze calc - recalculating

If you're lucky, the calculation you just did was perfect - 
all the oxides needed were supplied perfectly by the 
ingredients you chose. In that case, click % Batch and 
save the glaze recipe by choosing Send Recipe to 
Glazes from the Glaze Calculator menu.

If not, you'll need to recalculate.

Click the Clear Amts button to start calculating the 
recipe again. This only deletes the batch amounts that 
were calculated - the ingredient list and UMF are still 
there. You'll see the original UMF appear.

Change the ingredient list, adding new ingredients or 
rearranging the order of ingredients and try again. You 
can do calculations repeatedly in seconds!

Index

Calc TIP: putting an empty line 
between items in the ingredient 
list stops the calculations at 
that ingredient. Calculate one 
item at a time!

more...
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      Calculation tips - order of ingredients

Glaze calculation is quick and easy in HyperGlaze, but 
there are a few things that will make it go faster.

Put ingredients in the order of how many oxides they 
supply.  Put the ingredients with the most oxides at the 
top of the list, and the simpler ingredients at the end.
EXAMPLES: Feldspars contain sodium, potassium, 
alumina, and silica as major ingredients, along with 
smaller amounts of calcium and perhaps other oxides. 
Frits, gerstley borate and spodumene also supply 
several oxides. Put them at the top of the ingredient list.
Clays & kaolins are fairly complex - add them next.
Talc, dolomite, and wollastonite all have two oxides 
each - put them in the middle of the ingredient list.
Silica, whiting, and lithium carbonate, all contain just 
one ceramic oxide - put them at the end of the list.

Index

Calc TIP: Click the Sort 
Ingred List button to have 
HyperGlaze suggest the best 
order of ingredients.

more...
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      Calculation tips - combining K2O & Na2O

Most glazes and feldspars contain both potassium oxide 
(K2O) and sodium oxide (Na2O). Both of these alkaline 

oxides work in similar ways in glazes. Often it's safe and 
much easier to calculate glazes using a combined 
amount of these two oxides. For convenience, this 
combination is often referred to as KNaO.

HyperGlaze lets you combine sodium and potassium 
oxides in the Glaze Calculator and Glaze Limits.

Choose Combine K and Na in the Glaze Calculator 
menu to combine these oxides before calculating.

Index

KNaO TIP: 
Option [ALT] - click the 
chemical symbol K2O in the 
UMF to change to KNaO

more...

Find

Close

      Calculation tips - trace amounts

If your UMF (unity formula) has tiny amounts (below 
0.005 moles) of oxides like titanium dioxide (TiO2), iron 

oxide (Fe2O3) or phosphorus pentoxide (P2O5), it's often 

safe to delete these from the UMF before calculating, as 
they will be supplied anyway as trace ingredients of 
clays and other materials in the glaze. Deleting these 
trace amounts will make calculation go much easier, 
with the calculator focusing on the major oxides needed.

There are exceptions to ignoring trace amounts of 
oxides, for instance if you're trying to make a blue 
celadon with iron oxide, where keeping the amount of 
titanium dioxide to a minimum is critical to keep the 
glaze from going to more of a green color.

Index

Trace Amounts TIP: Click the 
Simplify UMF button to 
highlight it and have 
HyperGlaze ignore trace 
amounts automatically.
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      Calculation tips - tricks and hints

Sometimes HyperGlaze is fooled by trace amounts in an 
ingredient, typically in clays like kaolins or ball clay. Not 
as of the ingredient will be added as you think should be 
added. 

Try putting the same material twice in the ingredient list, 
then click Calculate. If this works the way you want, 
when calculations are done, click % Batch and 
HyperGlaze adds the two lines of the same material 
together in the recipe.

If you want to use multiple different clays, frits, or 
feldspars in the glaze recipe, see the USE Column help 
page.

Index

more...
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      The USE Column - multiple frits and spars

The USE column allows you to limit the amount of an 
individual material added in calculating a glaze in the 
Glaze Calculator. The USE column is to the right of 
each ingredient and amount. Enter USE amounts on the 
same line as ingredients you want to limit.

You can enter any amount in the USE column between 0 
and 1. Enter these as a decimal. For example, entering 
0.7 to the right of Soda feldspar will limit the amount of 
Soda feldspar added during the calculation to 70% (0.7) 
of the amount needed in the UMF. This allows adding 
another feldspar to fullfill the UMF.

Leaving the USE column amounts empty is the same as 
entering a one (1) - the full amount  of that ingredient is 
added during calculation.

Index

Calc TIP: the USE column 
often helps in glazes which 
need specific amounts of 
boron, soda and potash.
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Clays  - a recipe database of clay bodies

Clay recipe cards work very much like the Glaze recipe 
cards. All of the same calculations are done, with the 
exception of thermal expansion which cannot be 
accurately calculated for largely crystalline materials like 
clay bodies. The popup materials buttons [+] for 
ingredients have a slightly different list of materials on 
Clay cards, especially in the Also Add section.

The Graph UMF bar graph has been adjusted slightly to 
allow the display of the relatively larger amounts of silica 
and alumina in clays, compared to glazes.

There are also places to store a few descriptive words 
about the relative plasticity of the claybody, and also to 
record drying, firing and overall shrinkage. Enter any 
other pertinent information in the Comments field.

Index

Clay TIP: Estimated thermal 
expansion calculations are not 
accurate for clays, so that item 
is not on clay cards
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Materials Cards

Materials cards are a bit different than the Glaze and 
Clay cards. The Materials stack stores all of the 
analyses needed for glaze and clay calculation. It's 
important to keep this stack accurate. 

You'll probably need to add a few new materials to 
calculate glazes and clays made with your local 
materials. Get the analyses of your locally-available 
materials from your supplier or possibly from the 
manufacturer. Check for internet websites for suppliers 
and manufacturers, as these are often the fastest way to 
find the analyses of ceramic materials.

Typical materials analyses from suppliers are in the form 
of a percentage analysis. You can type this into 
HyperGlaze and convert it to a UMF (unity formula) by 
choosing Convert to Unity in the Materials menu.

Index

Material TIP: be sure to set the 
Material Type for each new 
material to make sorting and 
browsing easier. 
Try it above!

more...
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      Materials - new materials

You can easily add new materials to HyperGlaze, or 
make materials cards which use your own abbreviations 
or names for materials. Use New Card or Duplicate 
Card to enter new materials or variations on materials.

In the interest of sharing recipes with others, it's always 
best to use the most accurate name for a material. For 
example, using 'Custer potash feldspar' is better than 
just 'feldspar,' even though 'feldspar' may use the same 
analysis. If you print out this recipe and give it away, 
'feldspar' in another locale may mean a different brand - 
and result in a different glaze! Unique names speed up 
glaze calculation, too, by finding analyses faster!

On the next card, we'll enter a new analysis and convert 
it.

Index

Materials TIP: use Duplicate 
Card to make multiple 
Materials cards for variations 
on names for ingredients.
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      Materials - entering the new analysis

Once you have made a new Materials card, you can 
enter either a molecular formula (UMF) or more typically 
the percentage analysis by weight which you obtained 
from a supplier or manufacturer. Either way, type the 
amounts for each oxide in the material into the fields 
directly below the chemical symbol for that oxide.

If you have entered a percentage analysis, choose 
Convert to Unity from the Materials menu. The 
percentage analysis will appear in that field. It may differ 
slightly from the manufacturer's analysis, especially if 
the supplier's analysis doesn't add to 100!

Simple ingredients like silica are entered by putting a 1 
(one) under SIO2 and entering the molecular weight in 

the Mol. Wt. field. Hold down the option [ALT] key and 
click Mol Wt. to calculate simpler materials.

Index

Entry TIP: HyperGlaze will 
calculate the molecular weight 
for you! Or use Potter's Friend 
if you have the material's 
chemical formula.
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      Viewing options for Materials

In the Materials database, there are several other 
options for viewing the materials analyses. You can pick 
the options by clicking on them in the list (just like that at 
the right) on the bottom right side of any Materials card. 
When one of these buttons is chosen it changes the way 
the arrow buttons on the Materials cards work. The 
current glaze or clay is the recipe shown in the Glazes 
or Clays window, even if that window is not currently 
visible.
The options include: 
   View All - goes to all cards
   Current Glaze - shows only materials in current glaze
                 review what's in your glaze recipe
   Current Claybody - only materials in current clay
   View Marked  - shows only marked materials
   View Inventory  - shows only materials marked as 
                 being in your inventory (checked box)

Index

Materials tip: Use the choices 
above on any Materials card 
to view only the materials that 
you want to see.
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Printing

Printing is easy and flexible - you can print one card or 
recipe at a time by choosing Print Card, or many using 
Print Marked Cards. These will print the recipe or 
analysis as it appears on the screen. Comments which 
are longer than the visible Domments field won't be 
printed. Use a different printing format for recipes with 
lots of information in the comments.
There are several printing options for different formats of 
recipes and analyses, including long comments, 
comparison lists, cards, and labels. Try them out.

There are three more options that can be set in 
Preferences (click the Glazes tab) for formatting the 
printing of a glaze recipe: Print Window, Print 
Formatted, or Print Formatted with Picture. Print 
Formatted (with or without Picture) is highly 
recommended for Windows users.

Index

Printing TIP: Press the 
command [control]-P keys to 
quickly print one recipe card.

more...

Find



Close

      Printing Marked Cards

Once you've marked a few cards containing your 
favorite recipes, you'll probably want to print them. 
Choose Print Marked Cards from the File menu, and 
HyperGlaze will print only the cards you've marked.

You'll probably want to choose Page Setup the first time 
you print, to make sure you're print settings are 
satisfactory.

Make sure these are the recipes you want. If not, 
choose Unmark Card in the Glazes or Clays menu to 
deselect it. 
You'll probably want to make sure the batch sizes are 
correct, too. (See Glaze Index-Set Batch Size)

Index

Printing TIP:  Review the 
marked recipes first. Click View 
Marked  and go to each card 
with the arrow buttons.
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      Print Special - Limit Graphs & Labels

In the Glaze database of HyperGlaze you can print each 
recipe with its Glaze Limits graph. Choose Print Special 
in the File menu and then the submenu for either a 
single glaze with graph or all the marked cards. The 
recipe and graph should print with both on one page.

Printing labels for glaze containers is another option 
under Print Special in the File Menu. The format is set 
up for Avery 8254 3-1/3 x 4 inch shipping labels or the 
equivalent. The choice to print only the recipe, Marked 
Glazes as Labels 3.3x4, will print 6 recipe labels per 
sheet from the currently marked recipes. If you want to 
have both recipes and hazard warnings and the 
percentage analysis, choose Marked Glazes as Labels 
with Hazards.

Index

Glaze Book Tip: Make a quick 
glaze book or handout or 
recipes by using the label 
printing format on plain paper. 
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      Printing Material Analyses

You can print materials analyses as a table by choosing 
Print Special - Marked Cards as Analyses in the File 
menu of the Materials stack. Be sure to mark the cards 
you want to print first!

At this time this printing option works best for clays, frits, 
and feldspar which don't contain trace or unusual oxides 
not listed on the print out.
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Utility Stacks - helpful resources

Complex Search is a utility which makes finding and 
marking cards you want to view or print easier. It works 
with the Glazes, Clays, and Materials stacks.

There are four more stacks included in HyperGlaze 
which contain useful resources and tools for ceramists: 
Bibliography, Unity Explained, QuadBlender, and 
Potter's Friend.

Use these for everything from keeping track of books on 
ceramics, understanding more about glaze chemistry, 
doing glaze tests, to estimating and mixing plaster 
batches.
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      Complex Search

Complex Search helps to find cards in the Glazes, 
Clays, and Materials stacks using more complicated 
searches than are possible using the Find menu 
choices. In addition, it will find and mark many cards at 
once while you do something else. 

Finding things using multiple keys can be frustrating if 
you are asking for HyperGlaze to find a recipe with too 
many specific qualities. If you don't find any recipes, try 
a simpler search. (more on this on the next card)

Some of the Complex Searches may take time, 
especially if you have a lot of recipes to search in 
HyperGlaze. You can cancel a search by holding down 
the mouse button. If any cards have been marked 
before you cancel the search, you'll see that in the 
search results right above the Search button.
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      Complex Searches for glaze recipes

When looking for glaze recipes using Complex Search, 
you must specify a cone number. If you don't add any 
other search qualifications (or keys), then you'll find all of 
the recipes in the Glazes stack which have that cone 
number in the Cone field.

To find a smaller and more selective group of glazes at 
the same cone, you can add other search keys: aspects 
that the glaze does or does NOT have (use the NOT 
search fields). Keep these search keys short and simple 
to find more glazes. 

Use a repeat search after choosing "Find in the Found 
Set..." to further refine the set of recipes found. 
HyperGlaze will look only in the previously marked 
cards, and unmark any recipes which don't fit your 
search criteria.
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      Unity Explained - a tutorial about the UMF

The Unity Explained stack offers a discussion of 
various  topics related to glazes, their oxide makeup, the 
UMF, and other aspects of glaze calculation and 
formulation.

If you're unfamiliar with all of the chemical oxides that 
make up glazes, take some time to read through this 
stack. It's full of helpful information about how each of 
these oxides affects the final glaze.
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      Bibliography Stack

The Bibliography stack offers a list of ceramics books, 
mostly on glaze topics, which you can review. You can 
add your own book listings, too.

Clicking on a name or title in the list of books and 
authors on the index card will take you to that book's 
information.
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      QuadBlender

The QuadBlender stack helps with the math and logic 
of doing quadraxial and line blends of glazes or 
colorants. You can enter four separate glaze recipes in 
the QuadBlender, or just four materials or colorants. 

Clicking on any of the buttons on the numbered grid will 
give you the recipe for that test batch and tile. If you 
have entered four different glaze recipes, the 
QuadBlender will give you the final batch recipe of that 
test tile. 

Choosing Blend Recipe Grid from the QuadBlender 
menu will show a printable grid of volumetric recipes for 
making the actual tests from the four recipes: A, B, C, & 
D.

See also the Help menu of the QuadBlender.
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Testing TIP: Use volumetric 
blending for quick tests - 
teaspoon or tablespoonfuls to 
measure the glaze.
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      Potter's Friend

The Potter's Friend stack includes a number of useful 
tools, from simple weight and measure translations, time 
calculations for those long jobs, plaster working 
calculations, postage and material cost calculation, to 
calculating molecular weights from the chemical formula 
of ceramic materials.

Take a look and see if there's something there for you!
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Preferences

Use Preferences to adjust settings to your personal 
needs including:

  Turn Tool Tips on and off - in General preferences
   Save window locations -  in General preferences

  Set printing format in the Glazes preferences
       - determines how the recipe page prints

  Enter your own thermal expansion coefficients - in
      Thermal Expansion preferences

Please note that you must click the Save button (which 
also closes preferences) to make your changes 
permanent. Clicking on the close box in the bar at the 
top of the window will not save your preferences.
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Licensing Agreement

If you want to view the licensing agreement again after 
the initial start-up of HyperGlaze, click on the copyright 
notice on the Index window. You can view the software 
license for HyperGlaze and print a copy if needed.

Remember that a single user license for HyperGlaze 
allows you to install the software on two computers that 
you use: a desktop computer at work and either another 
desktop computer at home or portable computer. It does 
not allow installation of multiple copies of HyperGlaze in 
a computer lab or classroom or the copying of 
HyperGlaze for student computers.

If you'd like to use HyperGlaze in a lab situation, please 
purchase the site license which allows use on up to 25 
lab computers plus an instructor copy for a very low 
price.
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Troubleshooting

HyperGlaze is designed to be easy to use, but if you do 
have problems, here are some possible solutions.

If the software has an error, it will automatically generate 
an email message. Please send these if you see them 
pop up, as they contain information critical to making 
HyperGlaze work better for you. You can write to this 
same address if you have a problem using HyperGlaze: 
HGErrors@sbcglobal.net

Enjoy HyperGlaze!
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      Problem: can't save changes

One likely problem is if HyperGlaze is run directly from 
the HyperGlaze CD-ROM. CD-ROMs are read-only, 
meaning that HyperGlaze cannot save changes to the 
CD-ROM. Be sure to copy the appropriate HyperGlaze 
folder (Macintosh OS X or Windows) to your hard disk. 
Do this by dragging the entire folder to your computer's 
hard disk or desktop.

Windows users will also have to uncheck the 'Read 
Only' setting for the HyperGlaze files. Do this by opening 
the HyperGlaze folder on your computer's hard disk so 
that you see all of the parts of HyperGlaze.  Click on 
each file and look at it's Properties (in the File menu). If 
'Read Only' is checked, then uncheck it. You should only 
have to do this once after installing HyperGlaze from the 
CD-ROM.
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Lab TIP: HyperGlaze runs in 
memory, so you can leave 
Materials stack set to 'Read 
Only' in a lab to lock it from 
changes.
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      Problem: can't open stack

HyperGlaze expects to have all of its files in the same 
folder. Please don't rename files in the HyperGlaze 
folder as HyperGlaze looks for the original file names 
when opening stacks. 

It is possible for any computer file to become corrupted 
and unreadable. While this unfortunate event is unlikely, 
it is a wise idea to keep regular backups of HyperGlaze 
(and all of your files!) to another type of storage. Do this 
by either copying the HyperGlaze folder to your backup 
disk, or by using commercially- available backup 
software. If your files should be corrupted and 
unreadable, reinstall HyperGlaze from your backup or 
the original CD-ROM.

Make backups regularly! You don't want to lose all of 
your hard work entering your favorite glaze recipes!
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Backup TIP: make a 
HyperGlaze backup file 
immediately after entering new 
glazes into HyperGlaze!
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      Arrow buttons don't go to all cards

All of the database stacks in HyperGlaze have the 
option to view only the marked cards in that particular 
database when you click on the forward or backward 
arrow buttons. Make sure View Marked (just below the 
arrow buttons) is not highlighted in red when viewing all 
recipes. If it is, click on it to turn View Marked off.

In the Materials database, there are several other 
options for viewing. You can pick the options by clicking 
on them in the list (just like that at the right) on the 
bottom right side of any Materials card. 
The options include: 
   View All - goes to all cards
   Current Glaze - shows only materials in current glaze
   Current Claybody - only materials in current clay
   View Marked  - shows only marked materials
   View Inventory  - shows only materials in inventory
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      Problem: Glaze Calc adds too much

If you are trying to calculate a glaze batch from the 
molecular formula using the Glaze Calculator, and you 
continually get the message that the calculation has 
added too much of an oxide, you need to consider one 
or both of these things:

  -  Try rearranging the order of the ingredients in the 
      ingredient list.  Remember that more complex 
      ingredients which contain several oxides should 
      appear at the very top of the list. If your glaze needs
      something like boron or lithium, try adding an 
      ingredient which supplies that first! The Sort Ingreds 
      button does this automatically, and usually works.

   -  Check the analysis of ingredients in the Materials 
      stack to make sure ingredients you're trying to use 
      don't add an oxide which isn't needed.
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Calc TIP: click on chemical 
symbols for oxides and see the 
list of ingredients which supply 
those oxides.
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      Problem: searches end too quickly

You know there are recipes that satisfy your search but 
you keep getting "Search canceled after..." messages 
when using Complex Search.

It's likely that you're holding down the mouse button or 
clicking the mouse after the search begins.  Searches 
are canceled by holding down the mouse button. 

If you find that you inadvertantly start a new search with 
your cancelling click, then move the mouse cursor off of 
the Search button before clicking.
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      Importing PC .GLZ files on a Macintosh

If you have glaze recipes in a HyperGlaze file (.GLZ) 
which were saved on a Windows PC and you want to 
import them to your Macintosh version of HyperGlaze, 
do the following:

1. Hold down the Option key and choose Import from the 
File menu.

2. You'll see all of the files available, including many 
which are not HyperGlaze files. Pick the correct file 
ending in .GLZ to start the import of recipes.

HyperGlaze can import recipes it exports (.HGZ, .TXT 
and .RCP)  from Insight. HyperGlaze also import .RCX 
files from Insight, but does not export these files.
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Cross-platform tip: If you 
have moved files from a PC to 
a Mac, the icons may not 
appear correct, just make sure 
the file extension is correct.
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      Importing Files on a Windows PC

You must first start HyperGlaze, then choose Import 
from the File menu while in the proper database 
(Glazes, Clays, or Materials) to import a HyperGlaze 
recipe or material file. Find the file you want to import in 
the open file dialogue box and choose Open.

HyperGlaze can import recipes it exports (.HGZ and 
.TXT) and .RCP and .RCX formatted files from Insight.

Don't double-click the files - HyperGlaze doesn't open 
them that way. Sorry.
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